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n Introduction 
 

This is a program to simulate a scanning transmission electron microscope 
(STEM) image.  This program is designed as an optional function of 
xHREM™ (WinHREM™/MacHREM™), a program suite simulating a 
high-resolution electron microscope image for Windows/Mac OS.  
xHREM™ has the following features. 

 
Concept of xHREM™ 

1. User Friendly Graphical Interface 
xHREM™  employs user friendly Data Generation Utilities based on the 
Graphical User Interface for Windows or Mac OS. 

xHREM™ is general-purpose software that can be used to simulate all the 
images expected from any crystal systems, defect structures and interfaces.  
Although data generation for such general-purpose software normally 
becomes complex, a novice user can easily generate his/her data by using the 
graphical Data Generation Utilities with minimum requirements for the 
special knowledge. 

 

2. Reliable and Efficient Algorithm 
xHREM™ emerges from the HREM image simulation programs based on 
FFT multislice technique developed at Arizona State University, USA (see 
References).  This is one of the most reliable and efficient HREM image 
simulation programs. 

 

3. High Quality Image Output 
Numerical data such as projected potential, wave function propagating the 
specimen, simulated image intensities could be printed as high-quality gray 
scale maps (Bitmap) by using Output Graphic Utilities.  Numerical value of 
each pixel of the gray scale can be exported for further analysis with other 
software. 
 

Concept of STEM Extension 
1. User Friendly Graphical Interface 

STEM Extension employs user friendly Data Generation Utilities based on 
the Graphical User Interface for Windows or Mac OS. 
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2. Reliable and Efficient Algorithm 
Thermal Diffuse Scattering (TDS) is believed to be the main source of signal 
for STEM-HAADF image. STEM Extension will efficiently treat TDS using 
absorption potentials. Please consult the following paper for a detailed 
description: 
K. Ishizuka: A practical approach for STEM image simulation based on the FFT 
multislice method, Ultramicroscopy 90 (2001) 71-83. 

 

3. Efficient Computation 
STEM image simulation is number crunching, since scattering calculation is 
necessary at each scanning point. Therefore, the STEM Extension supports 
multi-core CPU to accelerate computation.  

Computation time of STEM image simulation can be reduced to about 1/20 
using an efficient interpolation method compared with the original versions. 

 

4. GPU (GPGPU) Support 
The STEM Extension supports GPGPU (General-purpose computing on Graphic 
Processing Unit) to further accelerate STEM performance. 

In the case of Windows, we support NVIDIA GPU(s) using NVIDIA CUDA 
(Compute Unified Device Architecture). The latest NVIDIA GPU has 10-20 
times computing power of a multi-core CPU, and gives you the performance 
equivalent to a cluster of 10-20 PCs at a low cost. Even an old GPU has 
computing power equivalent to several times of a multi-core CPU, and thus 
corresponds to a cluster of several PCs. In addition, our GPU module supports 
more than one GPU. Furthermore, our GPU module supports the GPU other 
than NVIDIA using OpenCL (Open Computing Language).  
In the case of macOS, our GPU module supports Apple Silicon GPU and 
third-party GPGPU using OpenCL. 
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n Installation 
 

STEM program (32bit version) and some sample data should be already 
installed into your hard disk, when you have installed xHREM Simulation 
Suite. 

In the case of STEM program (64bit version) please copy it manually to 
Programs folder of xHREM (STEMxx.exe is not an installer).  

When you purchase STEM program as an additional order, you have to 
update your user key. This update can be done by using Remote Update System 
(RUS). When you send current key information, then we will send back 
information to update your key. 

 

 
How to use GPU version (From Ver.5.0) 

The calculation module for the GPU is already installed according to your 
operating system, namely Windows or macOS. When a GPU(s) available for 
use is detected on your PC, the GPU module can become selectable in Option 
Tab of the STEM dialog.  

If the license is too old, you may have to update your license. In this case, 
you will obtain the massage saying “Feature not found”. 

 
How to evaluate xHREM without a user key (v4.1 or later)  

When a user key is not recognized, xHREM will run as a demonstration 
version. Then, you cannot calculate dynamical scattering using MultiGUI, 
However, you can get an experience on how to create an input data using the 
graphical user interface. Furthermore, for the sample data you can go through 
the steps for image simulation using the pre-calculated data that are included 
in the installer. 
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n Let's Start Tutorials 
 

Data Preparation 
Most of the data for scattering calculation control will be prepared by using 
"MultiGUI". A set of data specific to the STEM simulation will be specified 
in the optional windows.  Please consult xHREM User's Manual about the 
general scattering calculation controls.  

A sample data for GaAs (GaAs011s.WS1) will be provided with the program.  

When you use xHREM as a demonstration version, you cannot save an input 
data nor execute actual calculation. However, for the sample data you can go 
through the steps for image simulation using the pre-calculated data.  

 

In order to set up the optional data specific to the STEM simulation, click 
"STEM" from the Options at the bottom of the MultiGUI WORKSHEET. 

 

Then, the following window will open: 
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Basic tab 

    

1. Optical Parameters 

Input an aperture radius, aberration coefficients.  The aperture radius 
may be given in mrad (You have to select mrad in the Preferences before 
open this window.)  
You can perform calculations at multiple defocuses. Here, you can 
specify the center defocus, defocus step and a number of defocuses at 
over- and under-focus sides.  

2. Detector Parameters 

Detector radii of the bright-field imaging and the annular dark-field 
imaging will be specified here. These radii may be given in mrad, when 
you select mrad in the Preferences before open this window. 

(From v4.4) You can define the optional annular detector. Thus, you can 

1 

2 

3 
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simultaneously calculate ABF or LA-ADF, MA-ADF in addition to 
HAADF.  

(From v4.5) You can control the output for the DPC (Differential Phase 
Contrast) signals. Here, the DPC signals are calculated as the Center of 
Mass (CoM) of the diffraction intensity.  

3. Scan Control 

Scan Mode: Scanning scheme will be selected from the list shown below.  

 
Position: Scanning position(s) will be specified here.  The scanning 

positions will be specified in different ways according to the 
scanning mode.  
Area: The ranges (top, left; bottom, right) of the scanning area and 

numbers of scanning points along x and y will be specified for 
this mode. 

Line: The starting position and the ending position as well as the 
number of scanning points will be specified for this mode. 

Point: A single position will be specified for this mode. 
Whole Unit: The whole unit area will be calculated assuming an 

applicable symmetry. Thus, the two-dimensional symmetry 
group and an approximate scanning step (interval) will be 
specified. Integral number of scanning points will be 
calculated internally according to the approximate sampling 
interval.  
The supported symmetries: p1, p2, pm, pg, cm, pmm, pmg, 
pgg, cmm and p4.  

 
Data Output Cycle: STEM image intensity output interval in terms of the 

slices.  
List Output: the list output showing a scan progress. When a computing time for 

each slice is very quick, the scan list output may control the overall 
turnaround time. In this case, a simpler lit output is effective to shorten the 
turnaround time. 

 
 
When you select the GPU from the Option tab, the list output will be restricted 

only to Y:X…. 
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Option Tab 

 
 

1. High Order Aberration Coefficients 

High order geometrical aberration coefficients up to 5th order can be 
specified here. Although various definitions of the coefficients appear in 
the literatures, we simply define them in terms of wave aberration as 

.  

2. Super-cell Size 

Super-cell size used in computation will be selected from the following 
pull-down list. Normally, “Standard” can be selected here: € 

Cnm

(n +1)
α (n+1) cosm φ − φnm( )

2 

1 

3 
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The super-cell size in computation should be larger than the input 
structure model. If the structure mode is smaller than the super-cell size, 
the input model is repeated to fill the super-cell. Thus, the model size in 
computation is a multiple of the input model. 

3. Compute model Selector (Compute with) 

If any GPU (GPGPU) is not found, or the Cluster module is not 
installed in the Program folder, the corresponding compute model 
cannot be selected. 

When any NVIDIA GPU is available, the radio buttons, OpenCL and 
CUDA (NVIDIA), become active. We recommend to select CUDA for 
a NVIDIA GPU.  
When a GPU other than NVIDIA is available, only the radio button, 
OpenCL, become active. This is the case for Apple Silicon GPU. 

When you choose one of these radio buttons, the following dialog 
(GPU Selection) will open. Since no GPU is selected by default, please 
select here the GPU(s) to be used.  

 
NOTE: Please consult the topic GPU Acceleration for more details.  
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Super-cell size and sampling points*  

n Model Super-cell size 
(Target value) 

FT space interval  
(Target value) 

Sampling 
points* 

1 Test 12.5 A 0.08 / A 128 

2 Small 25 0.04 256 

3 Standard 50 0.02 512 

4 Large 100 0.01 1024 

5 Huge 200 0.005 2048 

6 Ultimate 400 0.0025 4096 

*The number of the sampling points is estimated for a rectangular 
unit cell assuming the calculation Range of 5.0/A (in d*).   
FT space interval = 1/(Super-cell size); Real space interval = 1/2d* 
Sampling points (power of two) > 2d*/(FT space interval) 

TIPS: The calculation limit in Fourier space is specified by “Range” at 
Preferences/Dynamical calculation. The numbers of the sampling point 
will increase proportionally with the Range. For an oblique system the 
required number of pixels becomes larger than the number shown here. 

TIPS: Normally, the Range of 5.0/A (in d*) is enough for calculation 
using HAADF TDS absorption potentials.  

When you use the Frozen Phonon model to emulate TDS (Thermal 
Diffuse Scattering) without using TDS absorption potential, you have to 
include in calculation the angle atomic scattering factor until it attenuates 
sufficiently, say up to d* = 30.0/A. Furthermore, using the Frozen 
Phonon model you have to calculate scattering from many atom 
coordinates (configurations), and average their intensities to give the 
TDS, which is not practical. 
TIPS: For STEM image calculation the super-cell less than “Standard” is 
not recommended in order to evaluate scattering profile. 

NOTE STEM simulation will use a super-cell with a large number of the 
sampling points.  Therefore, you will get a huge amount of the 
list output, when you try to print out the whole area of the potential 
distribution or the scattering distribution.  
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Dynamical Scattering Calculation 
1. Create the general scattering calculation controls in the main WORKSHEET.  

TIPS: To calculate elastic scattering to high-angle, a calculation range of 
s=1.5-2.0/A (d*=3.0-4.0/A) or higher will be set by Preferences -> 
Dynamical calculation > Range. However, “Doyle-Turner“ cannot be 
used above s=2.0/A. You have to select “Weikenmeier-Kohl” for a 
calculation beyond s=2.0/A. 

TIPS: Choose “Weikenmeier-Kohl Scattering Factor” from Preferences 
/Atomic Scattering factor, and check “Including TDS Absorption” box. 
However, when you want to ignore TDS absorption, and obtain a STEM 
image using only elastic scattering, you don’t need to check this box. 
Please note that including TDS absorption requires a thermal factor 
(Debye-Waller factor) of each atom.   

2. Set up the optional data for STEM simulation.  
3. Save the new data using “Save” or “Save As” from the File menu of the MultiGUI. 

(Before saving the data you can’t select the Execute command”.) 

When you are using xHREM as a demonstration version, skip the steps 
after this, since you cannot save an input data nor execute actual 
calculation. 

4. Launch STEM program by choosing "Execute STEM" from the File menu of the 
MultiGUI. 

5. A window showing the progress of the calculation appears. 

When an execution terminates normally, you will get the message 
"Execution completed. Congratulation!"  
TIPS: Calculation of a STEM image by scanning many points will take a 
long time. Thus, you can stop calculation and continue it layer. In order 
to resume calculation, choose “Append” from MultiGUI -> Multislice 
Calculation. When you stop calculation, a calculation will resume from 
the following scan point on which a full propagation has been completed.  

6. You can save the result window by choosing "Save As…" from the File menu 
of the result window. 
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Gray-scale STEM Images Display 
Gray scale STEM images will be generated by using the "STEMimage" utility.  
The STEM data has been output to a set of files depending on the output 
signal selections. However, all the signal can be accessed by selecting a .SD 
file.  

To display a gray scale STEM image, do this:  
1. Launch STEMimage. 
2. Select a ".SD" file with your sample name in the file selection dialog.  

When you can not find your SD file, confirm that the file type 
specification is "SD Data (*.SD)."  

The following window will be appeared. 

 

In the case you are using xHREM as a demonstration version, you can 
use a provided pre-calculated data (GaAs011s.SD). 
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3. Select "Display Mode" 

Select a display mode from "STEM Image", "Thickness Map" and 
"Point."  Selectable display mode is depending on the Scan Mode.  

As in this case of a two-dimensional scan image, you have to select the 
specimen thickness (slice number), a display area and a resolution 
(Pixels/length).  

When multiple defocus data is available, you can select a defocus value 
(or a center defocus value of Defocus Spread). 
When the Scan Mode is "Whole Unit," you can extend the display area 
more than one unit cell. 

4. From "Image Mode" you can select the image type from "Bright Field", "Annular 
Dark Field", “Optional ADF/ABF” (from v4.4) or “DPC” (from v4.6). In the annular 
detectors, you can also select the image signal(s) from TDS inelastic signal 
and/or coherent elastic signal. 
The “Optional ADF/ABF” can be selected only when you calculate this optional 
STEM signal. The “DPC” can be selected only when you calculate the DPC 
signal. 

5. Click "Generate" to display a gray scale image.  
In order to differentiate the signal source, “BF, “ADF”, “ADT” (Optional Annular 
Detector) or Dv and Dh (DPC signals) is added to the data name. 

TIPS: You can select one of the two interpolation methods (Fourier 
Transform/Bi-linear Interpolation) to estimate intensity between the 
calculated points. Usually, an interpolation using Fourier transform gives 
smoother image. Thus, a wider step (scan distance) can be used in calculation 
and a computation time may be substantially decreased.  

TIPS: Partial coherency due to a probe size as well as a defocus spread can be 
estimated. Here, Gaussian distributions are assumed for both the probe size 
and the defocus spread, and a full width at 1/e value is specified.  

NOTE: In order to estimate partial coherency due to a defocus spread the 
STEM images at multiple defocuses in a sufficient range should be calculated. 

TIPS: Each pixel value of a gray scale map produced by STEMimage can be 
output using “Save As…” command as you can do by using ImageBMP. The 
original data used to produce the gray scale map can also be output using 
“Save As…” command. Please consult “Numerical Data Output Using 
ImageBMP” in the xHREM manual for more details. 
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n Topics 
 

In this section some useful functions as well as advanced topics will be 
introduced.  It is not necessary to read through all the topics at the first time.  
You may want to study each topic when you need to use it.  
 

 
Including TDS Absorption 

You can include absorption of elastically scattered wave due to thermal 
diffuse scattering (TDS) in your dynamical calculation.  In this case, 
however, thermal displacement parameter (temperature factor; Debye-
Waller factor) for each atom in your atomic model is required.  When you 
don’t know a corresponding parameter, an approximate value may be 
specified.  

To include TDS absorption in your dynamical calculation: 

１． Launch MultiGUI 

２． Choose “Preferences” from Edit menu. 

３． Select “Weikenmeier-Kohl Scattering Factor” in “Atomic Scattering Factor” 
section of the Preferences dialog, and check “Include TDS absorption.” 
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Required RAM Size 
For STEM image simulation, scattering calculation is necessary at each 
scanning point. Then, we have to use all the phase gratings for each scan point. 
A cotemporary operating system (OS) allows us to use many phase gratings 
by using a virtual memory management. 

However, when a main memory is short to store only a single-phase grating, 
all the phase gratings should be read from an external memory as a result of 
roll-in/roll-out. If an external memory is a hard disk, a significant time is 
required to read the phase gratings into the main memory. Therefore, all the 
phase gratings should be stored in the main memory for an efficient 
computation.  

Typically, each program can use a roughly 2GB using a 32-bit OS. If the total 
phase gratings is bigger than this size, you have to use STEM Extension Pro 
that supports a 64-bit OS.  

TIPS: In the case of a Standard model with 512x612 pixels, each phase 
grating requires the following memory: 

(512x512) x 8 (complex) x 2 = 4MB. 

A larger model uses more phase gratings of larger size, so the total phase 
gratings will become more than 2GB.  
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STEM-DPC (Differential Phase Contrast) 
STEM-DPC is the technique to obtain a phase distribution of phase object 
using a STEM under the thick phase object approximation. A set of the DPC 
signals represents a vector corresponding to CoM (center of mass) of the 
diffraction intensity. This vector is a gradient of the phase distribution, which 
is proportional to a projected potential distribution of the sample.  

The DPC images, Dh and Dv, calculated with the STEM Extension 
correspond to the CoM, which are equivalent to the signal obtained from the 
pixelated detector. To obtain the DPC images corresponding to the 
experimental ones, however, you have to set the output resolution 
(pixels/angstrom) and the output range as in the case of other STEM images 
at the “Display Control” section of the xSTEMimage.  
The images below show the DPC images for the GaAs, which correspond to 
the horizontal (Dh) and vertical (Dv) derivatives of the potential distribution 
of GaAs in the 011 projection, respectively. 

  
In order to integrate the DPC signals using the qDPC plug-in for 
DigitalMicrograph, the DPC image data should be firstly read into 
DigitalMicrograph. You can easily import them to DigitalMicrograph, when 
you save the DPC images in “gfx” format using File -> Export Data from 
xSTEMimage as shown below:  

 
NOTE: When you output the DPC data from the xSTEMimage GUI using 
the Export command, you don’t need to generate the DPC images in advance, 
since both Dh and Dv images will be generated and saved at once. On the 
other hand, when you export the DPC image from the image window, only 
the corresponding image data, namely Dh or Dv image, will be saved. 
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The gfx file can be simply read into the DigitalMicrograph using “Open” 
command of the File menu.  In this case, you may need to select “All file” 
in the file type option to show the gfx file(s).  Or, you can simply drag-and-
drop the gfx file(s) to the DigitalMicrograph. 

The phase map shown below was obtained from the above two DPC images 
using “DCT…” command of the qDPC. 

 
 

Segmented Detector: There is a class of the DPC detectors that show the DPC 
images in real-time. The detectors segmented to four (quadrant) or eight 
(double quadrants) are commercially available. In this case the DPC signals 
are not exactly the CoM as given by a pixelated detector, but closely 
approximate the CoM. Therefore, using the DPC signal obtained with the 
xSTEM Extension you can get an idea on the phase image obtained by the 
segmented detector. 

 

References 
[1] qDPC, DigitalMicrograph plug-in: https://www.hremresearch.com/Eng/ 
plugin/qDPCEng.html (Microscopy Today 2018 Innovation Award product) 

[2] Ishizuka A., Oka M., Seki T., Shibata N., and Ishizuka K. (2017) 
Boundary-artifact-free determination of potential distribution from 
differential phase contrast signals. Microscopy 66, 397-405 (The Japanese 
Society of Microscopy Award in 2019 paper) 

[3] Ishizuka A. and Ishizuka K. (2020) Observation of Phase Objects using 
STEM - Differential Phase Contrast (DPC) microscopy, JEOL News 55, 24-
31. 
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GPU Acceleration  
When you want to use the GPU(s) to accelerate STEM calculation, select 
GPU Version from Compute model, and select OpenCL or CUDA 
(NVIDIA) radio button.  

 
NOTE: CUDA (NVIDIA) becomes selectable only when NVIDIA GPU 
is available. When NVIDIA GPU(s) will be exclusively used, we 
recommend you to select CUDA.  

Then, the following dialog (GPU Selection) will open. Since no GPU is 
selected by default, please select here the GPU(s) to be used. 

 
When you want to verify the selected GPU(s), or change the GPU selection, 
press GPU Selection button to open the selection dialog. 
NOTE: The name and its memory size of all the GPU(s) found on your PC 
will be shown in the output list generated by MultiGUI, together with their 
Use (1 or 0) and the number of points to be calculated (Batch) by each GPU 
as shown below: 

 
Here, you can check the GPU(s) used in the program by the value of Use (1 
or 0). The above output corresponds to the case where all the GPUs are used.  
NOTE: Currently, we assume the case where the same GPUs (or the GPUs 
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with the similar computing power) are installed on the PC, and give the same 
number of scan points (Batch number) to all the GPUs. Therefore, when you 
select a low performance GPU, the slowest GPU will control an overall 
computing time. In such a case, it may be more efficient not to include the 
low performance GPU(s). (This issue will be resolved in a future release.) 

 

The following extract of the list output shows the progress of scan in the case 
of 100 x 100 scan points for a full unit cell (x = 0.0 to 1.0; y = 0.0 to 1.0). In 
this case in order to optimize calculation a set of thirty-two (32) scan points 
is given to each GPU. When we use two GPUs, the first 32 points (1 to 32) 
are calculated by the GPU 0 (1:0), and the next 32 points (33 to 64) are 
calculated by the GPU 1 (33:1). Then, the GPU 0 calculates the third 32 points 
(65 to 96) (65:0), and so on. If the number of the scan points at the end of the 
scan line is less than 32, some points of the next line will be combined into 
the group of 32 points. In this case, since four (4) points (97 to 100) is left at 
the end of the first line, twenty-eight (28) points of the next line is combined 
in to 32 points and calculated by the GPU 1 as shown by (97:1). Thus, the 
next 32 points (29 to 60) of the second line is calculated by the GPU 0 (29:0).  

NOTE: The numbers before and after the colon (:) indicate the start scan point 
in each scan line and the GPU to be used, respectively. 

 
NOTE: In the above example the scan interval is 1.0/99 = 0.01010..., since 
the full range (0.0 to 1.0) is calculated by 100 of points to simplify the 
explanation. Thus, the value of Y becomes a multiple of 0.01010. If you use 
101 points for a full unit (0.0 to 1.0), the scan interval will become a simple 
fraction of 1.0/100 = 0.01, and the value of Y becomes a multiple of simple 
number of 0.01. 
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Close Multiple Bitmap Windows  
Each bitmap window will be closed by choosing "Close" from "File" menu 
or pressing the "Close" button of the bitmap window. When the bitmap 
image has not been saved, a warning dialog confirming data save will appear. 
This warning dialog will be suppressed, when the window is closed while 
pressing the "Shift" key. 
When you have calculated multiple bitmap images, it will be tedious to close 
each image window one by one. The following shows the handy ways to close 
the multiple bitmap windows. 

1) File menu (or Close button) of the bitmap window  

While pressing the "Alt" (Windows)/"Option" (Mac) key, you can choose the 
"Close" from "File" menu or press the "Close" button of the bitmap window. 
Then, all the bitmap windows will be closed one by one after confirming data 
save for the image that has not been saved. 
You can abort the closing process at any time by choosing the “Cancel” 
button in the save dialog.  

When the above closing process is activated while pressing also “Shift” key, 
all the bitmap windows will be closed without showing the save dialog. 

2) “Exit” (Windows)/”Quit” (Mac) (or Close button) of the STEMimage 
window  

All the bitmap windows will be closed after displaying the save dialog for 
each image before exiting from STEMimage application. 
You can abort the closing process at any time by choosing the “Cancel” 
button in the save dialog. 

When the above closing process is activated while pressing “Shift” key, all 
the bitmap windows will be closed without showing the save dialog. 
 

The same procedures will be used to close the multiple bitmap windows 
generated by ImageBMP. 
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FAQ 
Frequently Asked Questions 

 
This chapter will answer to 
Frequently Asked Questions 

with Q&A style 
 
 
 
STEM Extension 
Q401: An output from STEM image does not seem to represent a model structure 
Q402: How to select a super-cell size? 
Q403: Computation becomes extremely slow, when a model size becomes large. 
Q404: What is a range to be included for scattering calculation? Does this range depend 
on the model size? 
Q405: What is a strategy to shorten computation time? 
 
 
 

Q401 An output from STEM image does not seem to represent a model structure.  

  

A At first, check a projected model structure using Model Viewer (Model View of 
MultiGUI). If the projected model is displayed correctly, then check a scan step. If 
the scan step is larger than 0.3 A, you may not get a smoothed atomic structure. 
NOTE: If a displayed projected model structure is not correct, even when input atom 
parameters and a selected space group are right, then the symmetry operations of 
the selected space group may be wrong. If you find such an error, please report 
your finding to our support. 

 

Q402 How to select a super-cell size?  

  

A The size of a super-cell determines a sampling interval of Fourier space (an inverse 
of super-cell size corresponds to a calculation step of scattering distribution). 
Therefore, a super-cell size of larger than 5 nm (scattering calculation step of less 
than 0.2 /nm) should be employed for a good simulation.  

1. Crystal model 

If a unit cell of the model is less than 5 nm, select “Standard” from “Super-cell size.” 
Then, the input unit cell will be automatically repeated to create an approximately 
5-nm super-cell. If a unit cell of the model is larger than 5 nm, select a size of super-
cell larger than the unit cell. 
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2. Interface or a defect model 

Select an appropriate size of super-cell that is larger than the longer edge of the 
structure model. Other short direction will be automatically repeated to fill the 
selected super-cell.  

3. Model with no periodicity, such as a nano-particle  

Select an appropriate size of super-cell that can accommodate the whole model. 

 

Q403 Computation becomes extremely slow, when a model size becomes large.  

  

A STEM calculation requires all the phase gratings at each scan point. Therefore, even 
when a part of phase gratings cannot be loaded into the mail memory (RAM), all 
the phase gratings should be read from an external memory for each scan points in 
the case of a large model. Since computation speed of a contemporary PC is 
astonishingly fast, a total computation time will be extremely deteriorated due to 
this data access. 

To avoid this defect you have to install more RAM. If the total size of phase gratings 
becomes more than about 2GM, you may have to use the 64-bit version (STEM 
Extension Pro) that supports a 64-bit OS to handle more memory. 

 

Q404 What is a range to be included for scattering calculation? Does this range depend 
on the model size?  

  

A In order to evaluate probe propagation under elastic scattering, calculation including 
s=2.5/A (d*=5.0/A) is normally sufficient. This range does not depend on the model 
size.   

 

Q405 What is a strategy to shorten computation time?  

  

A Since STEM simulation requires scattering calculation at each scan point, a total 
computation time tends to become very long. The current version of STEM 
Extension supports Multi-CPU (core). Thus, if you use a PC with a multi-CPU, you 
can reduce a total computation time by a factor that is approximately a number of 
CPU (Core). 

A further reduction of computation time will be obtained, if you use a cluster version 
(STEM Extension Cluster) that uses multiple computers simultaneously. 

Furthermore, from v.5.0 the STEM Extension supports GPGPU (General-purpose 
computing on Graphic Processing Unit).  

In the case of Windows, we support NVIDIA GPU(s) using NVIDIA CUDA 
(Compute Unified Device Architecture). The latest NVIDIA GPU has 10-20 times 
computing power of a multi-core CPU, and gives you the performance equivalent 
to a cluster of 10-20 PCs at a low cost. Even an old GPU has computing power 
equivalent to several times of a multi-core CPU, and thus corresponds to a cluster 
of several PCs. In addition, our GPU module supports more than one GPU. 
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Furthermore, our GPU module supports the GPU other than NVIDIA using OpenCL 
(Open Computing Language) (from v5.2).  

In the case of macOS, our GPU module supports Apple Silicon GPU and third-party 
GPGPU using OpenCL (from v5.3).  

 


